Apple Pro Training Series

OS X Server Essentials

Arek Dreyer and Ben Greisler
Acknowledgments

We extend a big thank you to Steve Jobs. He will be missed, and he will continue to inspire us.

Thank you to all the people at Apple for getting Mountain Lion and OS X Server out the door.

Thank you to all the people who continue to help their users get the most out of OS X and iOS. Keep learning, and don’t expect the pace of change to let up any time soon.

Thanks to the amazingly capable Lisa McClain for gently making sure these materials made it into your hands, and to Darren Meiss and Kim Elmore for working their editorial and production magic.

Thank you, also, to the following people. Without your help, this book would be much less than what it is:

Craig Cohen       Adam Karnebog       Joel Rennich
David Colville    Andrina Kelly      Schoun Regan
Gordon Davisson   Bob Kite           Anthony Robinson
LeRoy Dennison    Andre LaBranche    John Signa
John DeTroye      Judy Lawrence      Chris Silvertooth
Kevin Dunn        Pam Lefkowitz      David Starr
Josh Durham       Ben Levy            Frank Valletutti
Charles Edge      Tip Lovingood      Cindy Waller
Eugene Evon       Jussi-Pekka Mantere Jeff Walling
Ben Harper        Nader Nafissi      Kevin White
Michael Gauss     Masayuki Nii       Simon Wheatley
Patrick Gallagher Tim O’Boyle        Josh Wisenbaker
Phil Goodman      Timo Perfitt       Kaoru Yamakawa
H Göck            John Poyner        Eric Zelenka
Eric Hemmeter     Mike Reed
Dedications

Arek Dreyer
Thanks to my lovely wife, Heather Jagman, for her cheerful support.

Ben Greisler
My love and appreciation to my wife, Ronit, and my children, Galee and Noam, for being there for me throughout this project.
## Contents at a Glance

### Configuring and Monitoring OS X Server
- **Lesson 1** About This Guide ........................................... 3
- **Lesson 2** Installing OS X Server .................................... 11
- **Lesson 3** Providing DNS .............................................. 69
- **Lesson 4** Exploring the Server App ............................... 85
- **Lesson 5** Configuring SSL Certificates ......................... 107
- **Lesson 6** Using Status and Notifications ......................... 147
- **Lesson 7** Backing Up OS X Server ............................... 159

### Configuring Accounts
- **Lesson 8** Managing Local Users .................................. 173
- **Lesson 9** Configuring Open Directory Services ............... 217
- **Lesson 10** Managing Local Network Accounts ................. 241

### Managing Devices with Configuration Profiles
- **Lesson 11** Configuring OS X Server to Provide Device Management 269
- **Lesson 12** Managing with Profile Manager ..................... 281

### Providing File Services
- **Lesson 13** Providing File Sharing Services ................... 313
- **Lesson 14** Understanding File Access ............................... 345
# Implementing Deployment Solutions

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Leveraging NetInstall</td>
<td>383</td>
</tr>
<tr>
<td>16</td>
<td>Implementing Software Update Service</td>
<td>411</td>
</tr>
</tbody>
</table>

# Providing Network Services

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>Offering Time Machine Network Backup</td>
<td>423</td>
</tr>
<tr>
<td>18</td>
<td>Providing Security via the VPN Service</td>
<td>433</td>
</tr>
<tr>
<td>19</td>
<td>Understanding DHCP</td>
<td>445</td>
</tr>
<tr>
<td>20</td>
<td>Hosting Websites</td>
<td>465</td>
</tr>
</tbody>
</table>

# Using Collaborative Services

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Providing Mail Services</td>
<td>489</td>
</tr>
<tr>
<td>22</td>
<td>Configuring the Wiki Service</td>
<td>507</td>
</tr>
<tr>
<td>23</td>
<td>Implementing Calendar Service</td>
<td>519</td>
</tr>
<tr>
<td>24</td>
<td>Providing Messages Service</td>
<td>533</td>
</tr>
<tr>
<td>25</td>
<td>Managing Contacts Service</td>
<td>545</td>
</tr>
</tbody>
</table>

Index ........................................................................... 553
Table of Contents

Configuring and Monitoring OS X Server

Lesson 1  About This Guide ................................. 3
Learning Methodology ...................................... 4
Lesson Structure ........................................... 5
Exercise Setup ............................................. 6
Apple Certification ........................................ 10

Lesson 2  Installing OS X Server ...................... 11
Reference 2.1 Evaluating OS X Server Requirements .................. 11
Reference 2.2 Preparing to Install OS X Server ......................... 15
Reference 2.3 Installing OS X Server ............................ 22
Reference 2.4 Upgrading or Migrating to OS X Server ................ 31
Reference 2.5 Updating OS X Server .............................. 32
Reference 2.6 Troubleshooting .................................. 33
Exercise 2.1 Configure OS X Before Installing OS X Server
on Your Server Computer .................................. 34
Exercise 2.2 Perform the Initial Installation of OS X Server
on Your Server Computer ................................. 48
Exercise 2.3 Configure Your Administrator Computer ............ 53
Additional Resources ....................................... 66
Lesson Review .............................................. 67
<table>
<thead>
<tr>
<th>Lesson 3</th>
<th>Providing DNS .......................................................... 69</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 3.1</td>
<td>What Is DNS? .......................................................... 69</td>
</tr>
<tr>
<td>Reference 3.2</td>
<td>Evaluating OS X DNS Hosting Requirements .................. 70</td>
</tr>
<tr>
<td>Reference 3.3</td>
<td>Configuring DNS Service in OS X Server .................. 71</td>
</tr>
<tr>
<td>Reference 3.4</td>
<td>Troubleshooting DNS Service in OS X Server ............. 72</td>
</tr>
<tr>
<td>Exercise 3.1</td>
<td>Configure DNS Services ............................................. 72</td>
</tr>
<tr>
<td></td>
<td>Additional Resources .............................................. 83</td>
</tr>
<tr>
<td></td>
<td>Lesson Review ......................................................... 84</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 4</th>
<th>Exploring the Server App ............................................. 85</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 4.1</td>
<td>Allowing Remote Access ............................................. 85</td>
</tr>
<tr>
<td>Reference 4.2</td>
<td>Using the Next Steps Drawer ..................................... 88</td>
</tr>
<tr>
<td>Reference 4.3</td>
<td>Using Server Sidebar Elements ................................... 90</td>
</tr>
<tr>
<td>Reference 4.4</td>
<td>Using the Manage Menu ............................................. 96</td>
</tr>
<tr>
<td>Reference 4.5</td>
<td>Using the Tools Menu ................................................ 97</td>
</tr>
<tr>
<td>Reference 4.6</td>
<td>Using Help ............................................................ 97</td>
</tr>
<tr>
<td>Reference 4.7</td>
<td>Troubleshooting ...................................................... 98</td>
</tr>
<tr>
<td>Exercise 4.1</td>
<td>Enable Screen Sharing And Remote Management ............ 99</td>
</tr>
<tr>
<td>Exercise 4.2</td>
<td>Explore the Next Steps Drawer .................................. 101</td>
</tr>
<tr>
<td>Exercise 4.3</td>
<td>Configure the Service Data Volume ......................... 102</td>
</tr>
<tr>
<td></td>
<td>Additional Resources .............................................. 103</td>
</tr>
<tr>
<td></td>
<td>Lesson Review ......................................................... 104</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 5</th>
<th>Configuring SSL Certificates ...................................... 107</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 5.1</td>
<td>Understanding SSL Certificates .................................. 107</td>
</tr>
<tr>
<td>Reference 5.2</td>
<td>Configuring SSL Certificates .................................... 110</td>
</tr>
<tr>
<td>Reference 5.3</td>
<td>Troubleshooting ...................................................... 121</td>
</tr>
<tr>
<td>Exercise 5.1</td>
<td>Create a Certificate Signing Request .......................... 121</td>
</tr>
<tr>
<td>Exercise 5.2</td>
<td>Import a Signed Certificate (Optional) ....................... 130</td>
</tr>
<tr>
<td>Exercise 5.3</td>
<td>Archive Your Certificate (Optional) .......................... 133</td>
</tr>
<tr>
<td>Exercise 5.4</td>
<td>Configure Your Server to Use Its New SSL Certificate ...... 136</td>
</tr>
<tr>
<td>Exercise 5.5</td>
<td>Configure Your Administrator Computer to Trust an SSL Certificate</td>
</tr>
<tr>
<td>Exercise 5.6</td>
<td>Clean Up</td>
</tr>
<tr>
<td>Additional Resources</td>
<td>144</td>
</tr>
<tr>
<td>Lesson Review</td>
<td>145</td>
</tr>
</tbody>
</table>

**Lesson 6**  
Using Status and Notifications | 147

**Reference 6.1**  
Monitoring and Status Concepts | 147

**Reference 6.2**  
OS X Server Alerts | 148

**Reference 6.3**  
Logs in OS X Server | 150

**Reference 6.4**  
Stats in OS X Server | 150

**Reference 6.5**  
Storage | 152

**Exercise 6.1**  
Use the Server App to Monitor OS X Server System | 152

**Additional Resources** | 157

**Lesson Review** | 157

**Lesson 7**  
Backing Up OS X Server | 159

**Reference 7.1**  
Backup Concepts | 159

**Reference 7.2**  
Time Machine | 161

**Exercise 7.1**  
Use Time Machine to Back Up OS X Server | 162

**Exercise 7.2:**  
Restore from Time Machine Backup (Optional) | 167

**Additional Resources** | 168

**Lesson Review** | 169

**Configuring Accounts**

**Lesson 8**  
Managing Local Users | 173

**Reference 8.1**  
Understanding Authentication and Authorization | 174

**Reference 8.2**  
Creating and Administering User and Administrator Server Accounts | 175

**Reference 8.3**  
Managing Access to Services | 187

**Reference 8.4**  
Troubleshooting | 189
Exercise 8.1  Create and Configure Local User Accounts .............. 190
Exercise 8.2  Import Local User Accounts ........................... 196
Exercise 8.3  Create and Configure Local Groups .................... 201
Exercise 8.4  Troubleshoot Problems with Importing Accounts ........ 207
Exercise 8.5  Manage Service Access .................................. 208
Exercise 8.6  Clean Up ........................................... 213
                     Additional Resources ................................. 215
                     Lesson Review ....................................... 215

Lesson 9       Configuring Open Directory Services ........ 217
Reference 9.1  Introducing Directory Services Concepts .............. 217
Reference 9.2  Configuring Open Directory Services .................. 225
Reference 9.3  Troubleshooting ..................................... 232
Exercise 9.1   Configure Your Server to Manage Network Accounts ..... 234
Exercise 9.2   Use Logs to Troubleshoot Using Open Directory ...... 238
                     Additional Resources ................................. 239
                     Lesson Review ....................................... 240

Lesson 10      Managing Local Network Accounts ............. 241
Reference 10.1 Using the Server App to Manage
                     Network User Accounts ................................ 241
Reference 10.2 Configuring Authentication Methods on OS X Server .... 245
Reference 10.3 Using Single Sign-On and Kerberos .................. 249
Reference 10.4 Troubleshooting ..................................... 253
Exercise 10.1   Create and Import Network Accounts .......... 254
Exercise 10.2   Configure Password Policies ......................... 260
                     Additional Resources ................................. 264
                     Lesson Review ....................................... 265
Managing Devices with Configuration Profiles

Lesson 11  Configuring OS X Server
to Provide Device Management. ............... 269
Reference 11.1  Profile Manager. ......................... 269
Reference 11.2  Configuring Profile Manager .......... 270
Exercise 11.1  Enable Profile Manager ................. 272
  Additional Resources. ................................ 278
  Lesson Review. .................................. 278

Lesson 12  Managing with Profile Manager ............. 281
Reference 12.1  Introducing Account Management ....... 281
Reference 12.2  Troubleshooting ......................... 287
Exercise 12.1  Use Profile Manager ..................... 288
  Additional Resources. .............................. 310
  Lesson Review. ................................. 310

Providing File Services

Lesson 13  Providing File Sharing Services. .......... 313
Reference 13.1  Addressing the Challenges of File Sharing ...... 313
Reference 13.2  Creating Share Points ...................... 321
Reference 13.3  Troubleshooting File Services .......... 330
Reference 13.4  Providing FTP Service (Optional) ........ 331
Exercise 13.1  Explore the File Sharing Service .......... 334
Exercise 13.2  Use Logs to Troubleshoot Problems
  with File Sharing Services ....................... 341
  Additional Resources. ......................... 341
  Lesson Review. ......................... 343
### Lesson 14

**Understanding File Access** .................. 345

Reference 14.1  
Configuring Access to Share Points and Folders ........ 345

Reference 14.2  
Understanding POSIX Permissions vs. ACL Settings ....... 350

Exercise 14.1  
Configure Access Control ............................. 364

Additional Resources ................................. 379

Lesson Review ....................................... 379

### Implementing Deployment Solutions

### Lesson 15

**Leveraging NetInstall** .............................. 383

Reference 15.1  
Managing Computers with NetInstall ................... 384

Reference 15.2  
Creating Images with System Image Utility .............. 388

Reference 15.3  
Understanding Shadow Files .......................... 393

Reference 15.4  
Troubleshooting NetInstall ......................... 394

Exercise 15.1  
Create NetInstall Images .............................. 395

Exercise 15.2  
Create NetBoot and NetRestore Images ................ 397

Exercise 15.3  
Configure a NetInstall Server ....................... 400

Exercise 15.4  
Filter NetInstall Clients ................................ 404

Exercise 15.5  
Configure a NetInstall Client ......................... 406

Exercise 15.6  
Monitor NetInstall Clients ................................ 408

Additional Resources ................................. 409

Lesson Review ....................................... 410

### Lesson 16

**Implementing Software Update Service** ...... 411

Reference 16.1  
Managing Software Updates .......................... 411

Reference 16.2  
Troubleshooting Software Update Service ............... 412

Exercise 16.1  
Configure Software Update ............................ 413

Exercise 16.2  
Configure Computers for Your Software Update Service .. 416

Additional Resources ................................. 419

Lesson Review ....................................... 420
# Providing Network Services

<table>
<thead>
<tr>
<th>Lesson 17</th>
<th>Offering Time Machine Network Backup</th>
<th>423</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 17.1</td>
<td>Time Machine as a Network Service</td>
<td>423</td>
</tr>
<tr>
<td>Exercise 17.1</td>
<td>Enable Time Machine Service</td>
<td>424</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>431</td>
</tr>
<tr>
<td></td>
<td>Lesson Review</td>
<td>432</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 18</th>
<th>Providing Security via the VPN Service</th>
<th>433</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 18.1</td>
<td>Understanding VPN</td>
<td>433</td>
</tr>
<tr>
<td>Reference 18.2</td>
<td>Configuring VPN with the Server App</td>
<td>434</td>
</tr>
<tr>
<td>Reference 18.3</td>
<td>Troubleshooting</td>
<td>437</td>
</tr>
<tr>
<td>Exercise 18.1</td>
<td>Configure the VPN Service</td>
<td>438</td>
</tr>
<tr>
<td>Exercise 18.2</td>
<td>Clean Up</td>
<td>442</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>443</td>
</tr>
<tr>
<td></td>
<td>Lesson Review</td>
<td>444</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 19</th>
<th>Understanding DHCP</th>
<th>445</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 19.1</td>
<td>Understanding How DHCP Works</td>
<td>446</td>
</tr>
<tr>
<td>Reference 19.2</td>
<td>Configuring DHCP Service</td>
<td>448</td>
</tr>
<tr>
<td>Reference 19.3</td>
<td>Troubleshooting DHCP</td>
<td>454</td>
</tr>
<tr>
<td>Exercise 19.1</td>
<td>Configure DHCP Service (Optional)</td>
<td>456</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>462</td>
</tr>
<tr>
<td></td>
<td>Lesson Review</td>
<td>463</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 20</th>
<th>Hosting Websites</th>
<th>465</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 20.1</td>
<td>Web Service Software</td>
<td>465</td>
</tr>
<tr>
<td>Reference 20.2</td>
<td>Understanding Basic Website Structure</td>
<td>465</td>
</tr>
<tr>
<td>Reference 20.3</td>
<td>Monitoring Web Services</td>
<td>467</td>
</tr>
<tr>
<td>Reference 20.4</td>
<td>Troubleshooting</td>
<td>467</td>
</tr>
<tr>
<td>Exercise 20.1</td>
<td>Enable Web Services</td>
<td>468</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Exercise 20.2</td>
<td>Secure Your Website</td>
<td>479</td>
</tr>
<tr>
<td>Exercise 20.3</td>
<td>Monitor Web Services</td>
<td>483</td>
</tr>
<tr>
<td>Exercise 20.4</td>
<td>Disable a Website</td>
<td>485</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>485</td>
</tr>
<tr>
<td></td>
<td>Lesson Review</td>
<td>486</td>
</tr>
</tbody>
</table>

**Using Collaborative Services**

<table>
<thead>
<tr>
<th>Lesson 21</th>
<th>Providing Mail Services</th>
<th>489</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 21.1</td>
<td>Hosting Mail Services</td>
<td>489</td>
</tr>
<tr>
<td>Reference 21.2</td>
<td>Troubleshooting Mail Services</td>
<td>493</td>
</tr>
<tr>
<td>Exercise 21.1</td>
<td>Enable the Mail Service</td>
<td>494</td>
</tr>
<tr>
<td>Exercise 21.2</td>
<td>Send and Receive Mail</td>
<td>498</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>505</td>
</tr>
<tr>
<td></td>
<td>Lesson Review</td>
<td>506</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 22</th>
<th>Configuring the Wiki Service</th>
<th>507</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 22.1</td>
<td>Understanding and Managing a Wiki</td>
<td>507</td>
</tr>
<tr>
<td>Reference 22.2</td>
<td>Troubleshooting the Wiki Service</td>
<td>508</td>
</tr>
<tr>
<td>Exercise 22.1</td>
<td>Enable the Wiki Service</td>
<td>508</td>
</tr>
<tr>
<td>Exercise 22.2</td>
<td>Create a Wiki</td>
<td>513</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>517</td>
</tr>
<tr>
<td></td>
<td>Lesson Review</td>
<td>517</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 23</th>
<th>Implementing Calendar Service</th>
<th>519</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 23.1</td>
<td>Calendar Service Data Locations</td>
<td>519</td>
</tr>
<tr>
<td>Reference 23.2</td>
<td>Using the Calendar Service</td>
<td>519</td>
</tr>
<tr>
<td>Reference 23.3</td>
<td>Troubleshooting the Calendar Service</td>
<td>520</td>
</tr>
</tbody>
</table>
This page intentionally left blank
Lesson 4
Exploring the Server App

Once you’ve completed your initial installation and configuration of OS X Server and you click Finish at the Congratulations pane, the Server app opens its main configuration pane and you can continue configuring it. In this lesson you’ll learn about the various panes available in the Server app. You will learn how to enable remote access to the Server app and how to move the location your server uses to store much of its service data.

Reference 4.1
Allowing Remote Access

You can certainly administer your server on your server computer, however, even though OS X Server is now an application, rather than an entire operating system, it’s still not recommended to use your server for your daily productivity applications. Additionally, your server computer might be located in an inconvenient physical location.

You can use the Server app on a Mac with Mountain Lion to manage OS X Server running on a remote Mac, but only if the checkbox “Allow remote administration using Server” is selected. It is recommended that you do not simultaneously use the Server app on more than one Mac to administer a given server.

MORE INFO ► When you select the “Allow remote administration using Server” checkbox, you enable other Macs to use the Server app to configure your server using TCP port 311.

GOALS

▶ Understand how to use the Server app
▶ Use the Server app to administer a remote computer with OS X Server
▶ Move service data to a different volume
Unlike previous versions of OS X Server, you cannot perform a remote initial installation and configuration of OS X Server with the Server app; you have to use the Server app on the Mac on which you want to install OS X Server, at least for the initial installation and configuration.

However, sometimes you need direct control of your server computer; for example, to perform a series of file or folder copy operations using the Finder. If you select the checkbox “Enable screen sharing and remote management,” you can use tools like Screen Sharing (available from the Tools menu in the Server app, and located in /System/Library/Core-Services), and Apple Remote Desktop (available from the Mac App Store) to take control of the Mac running OS X Server.

When you select the “Enable screen sharing and remote management” option, this allows access for any local accounts on the server computer that you configure as an administrator. If you want to allow access for other accounts, or specify a password for software that uses the VNC protocol, configure this in the Sharing preferences on the server computer.

**NOTE** If you have the Sharing preferences open when you use the Server app to configure a user account as an administrator, you need to quit System Preferences and reopen the Sharing pane to see the updated list of accounts.
The following figure illustrates the checkbox in the Sharing preferences that is enabled when you enable the checkbox for “Enable screen sharing and remote management.”

The “Allow remote login using SSH” checkbox in the Server app has the same effect as the Remote Login checkbox in the OS X Sharing preferences; selecting or deselecting either checkbox has the same effect on the checkbox in the other tool.

When you run the Server app on a remote administrator computer, if the “Allow remote login using SSH” option is selected, an arrow appears next to it. If you click this arrow, the
Server app opens Terminal and attempts to connect to your server using the SSH protocol, with the username of the administrator account that you provided to the Server app to connect to your remote server computer. You must provide the password to successfully open an SSH connection.

Similarly, there is also a shortcut to open a Screen Sharing session with your server. This opens the Screen Sharing application, which allows remote observation and control of the remote server computer.

Of course, the checkbox for “Allow remote administration using Server” is not available for you to configure unless you use the Server app directly at the server.

The following figure illustrates the arrows that are shortcuts to open a connection to the server.

**NOTE** At the time of this writing, a reinstallation of OS X Mountain Lion from the Recovery HD results in the Sharing preferences with Screen Sharing enabled for local administrator user accounts, and Remote Login (SSH shell access) enabled for all local user accounts. If you upgrade from OS X v10.6.8 or any version of OS X v10.7, your Mac with OS X Mountain Lion inherits the Sharing settings from the system you upgraded.

Reference 4.2

Using the Next Steps Drawer

The Next Steps drawer is at the bottom of the Server app window, and is a great introduction to the Server app. Once you are more familiar with the Server app, you can click the Next Steps button to close the Next Steps drawer. You can always click the Next Steps button to open the drawer again.

The five sections in the Next Steps drawer are pretty self-explanatory:
Configure Network
You should have already configured your network interfaces the way you want, but the Configure Network pane gives you a quick view of your current network configuration, as well as a shortcut to your server’s Network pane in the Server app.

NOTE ▶ Changing your server’s IP address can have significant unexpected consequences, depending on the services your server provides. Search for “Find or change your server’s IP address” in the online “OS X Server: Advanced Administration” for more information.

Add Users
Lessons 8 and 10 delve into managing local users, as well managing local network users. The Add Users pane offers some advice and a shortcut to the Server app’s Users pane.

Review Certificates
You will learn about using SSL certificates in the next lesson. One blue link opens Server Help, and the second is a shortcut to the Settings pane where you can configure SSL certificates.
**Start Services**
This pane lists any currently running services. The Server app sidebar displays a green status indicator next to any service that’s running.

**Manage Devices**
You will learn more about managing Macs and iOS devices in Lesson 11, “Configuring OS X Server to Provide Device Management,” and in Lesson 12, “Managing with Profile Manager.”

**Reference 4.3**
**Using Server Sidebar Elements**
The Server app’s sidebar contains four sections, which you’ll use over and over throughout this guide.

**Hardware**
The Hardware section displays your server, as well as an AirPort device if there is one on your subnet.
If you select the AirPort device, and provide authentication to manage the AirPort device, when you use the Server app to start some services for the first time, the Server app asks if you would like to modify the AirPort device’s NAT rules to allow outside access to the service. This is convenient if an AirPort device sits between your internal network and your connection to the Internet.

Once you select your server in the Server app sidebar, you see four tabs:

- Overview
- Settings
- Network
- Storage

**Overview**

The Overview pane is the first thing you see after your initial installation and configuration of OS X Server. The arrow next to your Startup Disk is a shortcut to clicking the Storage tab and selecting the startup volume.
**Settings**
The Settings pane offers a number of options to configure remote access and administration.

This is also where you edit your server’s SSL certificates; remember that the Next Steps Review Certificates pane contains a link to this Settings pane.

The last option in the Settings pane allows you to configure your server to store data for various services on a volume other than the boot volume.

---

**Moving Service Data Location**
When you click Edit next to the Service Data field, you have the opportunity to change where your server stores some of its service data. Here’s what the pane looks like for a server with two internal volumes and one external volume:
If you use the Server app to choose a different service data volume, it does the following:

- Automatically stops the appropriate services
- Creates a new folder on the volume you choose (/Volumes/volume_name/Library/Server)
- Copies the existing service data to the new folder
- Configures services to use the new location
- Starts the services again

The list of services whose data gets relocated includes:

- Calendar and Contacts
- Mail
- Messages
- PostgreSQL databases and backups that services like Profile Manager use
- Profile Manager
- Software Update
- Websites
- Wiki

Not all the server’s service data is moved. For example, configuration and temporary files (like the Mail spool file) remain on the startup volume, and some services, like FTP, NetInstall, and Websites, offer separate interfaces to choose where to store data for those services.

Just as you should not change the name of your server’s startup volume after you start offering services, you should not change the name of the service data storage volume after you designate it in the Server app.

MORE INFO ▶ If you choose to share the Websites root via FTP, it will share the /Library/Server/Web/Data/Sites/ directory on your server’s volume, even if you choose a different data volume for your server’s service data.
**Network**
The Network pane shows your current Computer Name and Host Name, as well as the status of your server’s network interfaces.

![Network Pane Example](image)

**Storage**
This Storage pane displays an alphabetical list of the disks connected to your server computer; you can also drill down and edit file ownership, permissions, and access control lists (ACLs). You’ll see more about this pane in Lesson 14, “Understanding File Access.”

![Storage Pane Example](image)
If you have multiple volumes attached to your server, only the boot volume has special folder icons for the Applications, Groups, Library, Shared Items, System, and Users folders. Other volumes have regular folder icons.

**Accounts**

**Status**
Lesson 6, “Using Status and Notifications,” covers using the Alerts, Logs, and Stats panes to proactively monitor your server.

**Services**
This is a list of the services that OS X Server offers. A green status indicator appears next to the services that are currently running. Select any service to configure it.

MORE INFO ► The “Additional Resources” section of Lesson 2, “Installing OS X Server,” contains a list of Knowledge Base articles that address services that have been offered in previous versions of Mac OS X Server but do not appear in this list of services.
Reference 4.4
Using the Manage Menu

The Server app’s Manage menu offers three menu items.

“Connect to Server” opens the “Choose a Mac” pane, where you see a list that includes your Mac, servers in your broadcast domain, and Other Mac, which allows you to specify another Mac by its host name or IP address.

The “Import Accounts from File” menu item is covered in Lesson 8, “Managing Local Accounts,” and Lesson 10, “Managing Local Network Accounts.”
**Reference 4.5**

**Using the Tools Menu**

The Tools menu allows you to quickly open four administration applications:

- Directory Utility
- Screen Sharing
- System Image Utility
- Xsan Admin

The first three applications are located in `/System/Library/CoreServices` on every Mac with OS X Mountain Lion. Xsan Admin is located inside a folder in the Server app itself.

---

**Reference 4.6**

**Using Help**

Don’t underestimate the power of the Server Help. After you enter search terms into the Search field, Help displays a list of Server Help resources that match your query.
Once you choose a topic from the list of results, the Help Center window stays in the foreground until you close it.

Reference 4.7
Troubleshooting

If your administrator computer does not have DNS records available for a remote server, you will not be able to authenticate to that server with the Server app.

On your server, do not delete the Server app or move the Server app from the Applications folder on your startup volume. If you do, you will see a dialog that all your services have stopped; when you reinstall OS X Server (or just move the Server app back into the Applications folder of the server's startup volume), you will have the opportunity to reenter your Apple ID to renew your Apple Push Notification service certificates, and then your services will start again.

It is recommended that you do not change the name of your server’s startup volume, but if you do, you will need to restart your server to restart its services.
Exercise 4.1
Enable Screen Sharing And Remote Management

In Exercise 2.2, you confirmed that your server allows remote administration using the Server app. Now you will enable screen sharing and remote management as well. If you had a copy of Apple Remote Desktop, performing this action would allow you to use it to control your server. In this exercise you will use Screen Sharing to control your server.

Open a connection to your server with the Server app if you don’t already have one open.

1. On your administrator computer, open the Server app, and choose Manage > Connect to Server. Select your server and click Continue.

2. Provide administrator credentials (Administrator Name ladmin and Administrator Password ladminpw).

3. Click Connect.

Enable screen sharing and remote administration.

1. If your server isn’t already selected in the Server app sidebar, select your server now.

2. Click the Settings tab.

3. To enable you to open a Screen Sharing session using the Server app on a remote administrator computer, select the checkbox “Enable screen sharing and remote management.”
Open a Screen Sharing connection.

1. Click the arrow next to the “Enable screen sharing and remote management.”

2. Enter local administrator credentials for your server computer.

   **NOTE** If you provided your Apple ID when setting up OS X, you will see “Connect as a registered user” and “Using an Apple ID” as two different options in the window. If this is the case, select “Connect as a registered user” and enter credentials for the local administrator on your server.

   **NOTE** The Name field automatically contains the full name of the currently logged-in user on your administrator computer.

3. Click Connect.

4. Move some windows around to demonstrate that you are controlling your server computer.

5. In the Screen Sharing window, click the close button.

Because you selected the checkbox for “Enable screen sharing and remote management,” you were able to take control of your remote server computer using Screen Sharing, right from the Server app’s shortcut.
Exercise 4.2
Explore the Next Steps Drawer

The Server app has a helpful Next Steps drawer that helps you determine your next management and monitoring steps.

Like many exercises in this guide, you can open the Server app on your administrator computer, or on your server computer.

1. If it isn’t already open, open the Server app and connect to your server.

2. In the Next Steps drawer, click Configure Network. Review the text, which contains information about your IP address and host name and instructions for changing these.

3. In the second sentence, click the blue word “Server,” which is a link to the Network pane; this produces the same result as selecting your server in the Server app sidebar and then clicking Network.

4. Unlike earlier versions of OS X Server, if you want to change your IP address or host name, you do not have to use the command line. To access the appropriate interface to change your IP address or host name, click Edit next to the Host Name field.

5. In the Change Host Name pane, click Continue.

6. If you see the Multiple Networks Detected pane, confirm that the pop-up menu contains your primary network connection, and choose Continue.

7. In the Host Name pane, select “Host name for Internet” and click Continue.

8. Review the computer name, host name, and network address. This is where you would make changes when appropriate, but for the purposes of this guide, do not make any changes at this point: Click Go Back as many times as it takes to get back to the Change Host Name pane, and then click Cancel.
9 Click the four other Next Steps buttons and review their content.

10 Click the Next Steps button in the lower-left corner to make the Next Steps drawer disappear.

11 Click the Next Steps button again to make the drawer reappear.

The Next Steps drawer is a great place to start when you're new to administering your server with the Server app, but you can close the Next Steps drawer when you're more familiar with the Server app.

**Exercise 4.3**

**Configure the Service Data Volume**

**Prerequisite**

- Exercise 4.1, “Enable Screen Sharing And Remote Management”

In this exercise, you will go through the procedure to relocate your service data volume but will not actually change it.

**Moving the Service Data to a Different Volume**

Using the Server app, you can choose a different volume for service data. It's a good idea to perform this task as early as possible, so that you don't have to wait with services disabled while a large amount of data is moved to the new volume.

1 If necessary, on your administrator computer, open the Server app and connect to your server.
In the Server app sidebar, select your server and click Settings.

Next to the Service Data field, click Edit.

Inspect the current Service Data Size, as well as how much space is available on any listed volume. If you have another volume available on which to store the service data, you could select that volume and click Choose.

Because it is possible that you do not have any extra volumes in your test environment, the rest of the exercises for this guide are written with the assumption that the service data is stored on the startup volume. So, for the purposes of these exercises, click Cancel to close the window.

Even though you went through the procedure to relocate your service data volume, you didn't actually change it in this exercise. You can use this procedure in a production environment with an additional storage volume.

### Additional Resources

The following documents provide more information about using the Server app to manage and configure OS X Server.


#### OS X Server Administration Guides


#### Apple Knowledge Base Documents


- Document HT1822, “OS X Server: Admin tools compatibility information”
- Document HT4974, “OS X Server: Changing the service data storage location”
- Document HT4814, “How to administer OS X Server remotely using Server App”
- Document HT5359, “OS X Server: Dedicating system resources for high performance services”
Lesson Review

1. Using an administrator computer with the Server app installed, how do you use the Server app to administer a remote server?

2. What option do you need to select in order to allow another Mac to administer your server, and where is its checkbox?

3. What tools does the Tools menu give you quick access to open?

4. Do you have to install extra software to take control of your server’s keyboard and mouse?

5. How do you hide the Next Steps drawer?

6. If you use the Server app to choose a different service data volume to a volume called /Volumes/Data, what folder will contain the service data?

7. Do you need to stop all services before using the Server app to change your service data volume?

8. Can you remotely install OS X Server on a brand new Mac computer that comes with OS X Server, without first configuring OS X on that computer?

Answers

1. Open the Server app, choose Manage > Connect to Server, select your remote server from the list (or select Other, and then provide its host name or address), and provide credentials for a local administrator.

2. Select your server in the Server app sidebar (in the Hardware section), click the Settings tab, and then select the option “Allow remote administration using Server.”

3. The Tools menu gives you access to these applications:
   - Directory Utility
   - Screen Sharing
   - System Image Utility
   - Xsan Admin

4. No, on your server computer, you open the Server app and select your server in the Server app sidebar (in the Hardware section). Click the Settings tab, select the checkbox “Enable screen sharing and remote management,” and then on your administrator computer use Screen Sharing to take control of your server computer’s keyboard.
5. Click the Next Steps button, or choose Help > Next Steps Button.

6. In this case, your service data will be stored in /Volumes/Data/Library/Server.

7. No, the Server app automatically stops the appropriate services before moving their data to the new service data volume.

8. No, you need to configure OS X before installing and configuring OS X Server.
This page intentionally left blank
Symbols and Numbers

~ (tilde character), 207
80 ports, 467
443 ports, 467, 471
8080 ports, 466, 473–474
8088 ports, 412, 420

A

AATC (Apple Authorized Training Center), 6
About This Mac, 12–13
Access, Keychain. see Keychain Access
Access control entries (ACEs). see ACEs
(access control entries)
Access control lists (ACLs). see ACLs
(access control lists)
Access Control, Media. see MAC (Media Access Control) addresses
Access logs, 467
Access to files. see file access
Access to services
 groups managing, 189
in local network accounts, 244
in local user accounts, 180, 187–189, 208–212
in Open Directory, 225
troubleshooting, 190
Accessing Your Server pane, 23–24
Accounts
 for administrator servers. see administrator server accounts
credentials of, 173
discharging of, 246
for groups. see local group accounts
management of. see Profile Manager
for networks. see local network accounts
Server app section on, 95
for users. see local user accounts
ACEs (access control entries)
complex permissions for, 355–356
in File Sharing pane, 346
in group folders, 327
introduction to, 220
for read-only access, 366, 376–378
share points and, 323, 327
sorting ACLs canonically and, 359
in Storage pane, 349–350
ACLs (access control lists)
- complex permissions for, 355–356
- in File Sharing pane, 353
- in file sharing services, 313, 319–320, 327
- file system, 352
- GIDs for, 360–361
- group membership and, 361
- GUIDs for, 360–361
- inheritance in, 357–358
- multiple groups in, 361–362
- nested groups in, 362
- portability of, 359
- POSIX and, 350–351, 360–363
- propagating permissions in, 359–360
- rules of precedence in, 362–363
- sorting canonically, 359
- in Storage pane, 354–355
- UIDs for, 360–361
- updating, 359, 373–374, 376

ACMT (Apple Certified Macintosh Technician), 10

ACSP (Apple Certified Support Professional 10.8), 10

ACTC (Apple Certified Technical Coordinator 10.8), 10

Active Directory (AD), 71

Add Users pane, 89

Administrator computers
- accounts for. see administrator server accounts
computer names in, 58–59
DNS records in, 61–62
Energy Saver in, 59
existing OS X system configurations for, 54–55
independent readers and, 63–64
installing OS X Server on,
generally, 53
introduction to, 9
names of, 58–59
network interface configuration in, 60–61
permissions and. see administrator permissions
Remote Management in, 58–59
server administration in, 65–68
Server app installation on, 64–65
Setup Assistant in, 55–58
Software Update in, 59–60
Software Updates folder in, 62–63
SSL certificates and, 138
Student Materials in, 62–64
VPN service on, 439–441

Administrator permissions
- in complex permissions, 355–356
- for local user accounts, 175, 180–181

Administrator server accounts. see also administrator computers
configuration of, 176–179
importing accounts in, 184–185
importing lists of users in, 185–186
introduction to, 175–176
local groups and, 181–184
local user accounts and, administration rights for, 180–181
local user accounts and, generally, 179
local user accounts and groups in,
182–183
users accessing files/services on, 180
AFP (Apple Filing Protocol) services
case sensitivity in, 330
Connected Users pane and, 328–329
Error log in, 321
in file sharing services, 315–318
Finder and, 258–260
guest access in, 327
introduction to, 26
in local network accounts, 258–260,
262–263
in local user accounts, 174, 189,
209–210
share points in, 322
AirPort
Extreme, introduction to, 7
Management pane in, 29
in Server app, 90
wireless networks and, 156
Alerts pane, 148–149, 154–156
Aliases, 179
Anonymous binding, 231
Apache, 465–467, 483
APNs (Apple Push Notifications). see Apple Push Notifications (APNs)
Apple
AirPort by. see AirPort
IDs, 271, 275–276
Knowledge Base by. see Knowledge Base documents
Open Directory by. see Open Directory
OS X Server certification by, 10
Apple Authorized Training Center (AATC), 6
Apple Certified Macintosh Technician (ACMT), 10
Apple Certified Support Professional 10.8 (ACSP), 10
Apple Certified Technical Coordinator 10.8 (ACTC), 10
Apple Filing Protocol (AFP). see AFP (Apple Filing Protocol) services
Apple Pro Training Series: OS X Support Essentials
on network locations, 460
on recovery, 18
on volume formats, 16
Apple Push Notifications (APNs)
alerts for, 148–149, 152–156
in installation of OS X Server, 29–30
introduction to, 7
in Profile Manager, 283
Apple Remote Desktop (ARD), 383
Apple System Restore (ASR), 383
Apple Training Series: Mac OS X Server Essentials v10.6, 270
Archives
in Messages service, 537
SSL certificates in, 114–115, 133–136
ARD (Apple Remote Desktop), 383
ASR (Apple System Restore), 383
Authenticated binding, 231
Authentication
definition of, 173
in Kerberos, 253
of local network accounts, 249–253
of local user accounts, 173–175
Authorization
definition of, 173
of local user accounts, 173–175, 210–212
Automatic push, 283
Automatically configured DNS, 70–71
Automator, 389
Availability, 15

B
Backups of OS X Server
introduction to, 159–160
resources on, 168–169
restoring OS X Server from, 167–168
review of, 169
Time Machine for, 160–166
Binding
anonymous, 231
authenticated, 231
OS X to Open Directory, 218, 232
servers to directory servers, 230–232
Blacklists, 493, 497–498
Blogs. see Wiki services
Boot disks, 385. see also NetBoot
Boot images, 389–390
BootP (Bootstrap Protocol), 448, 456
Browsing. see Finder
Buddies, 538–540

C
CalDAV, 519, 531
Calendar service
configuration of, 521–524
data locations in, 519
introduction to, 519
Knowledge Base documents on, 532
locations in, 524–526
in mail services, 498–502
resources in, 524–526
resources on, 531–532
review of, 532
Server app for, 524–526
starting, 521–524
troubleshooting, 520–521
user access to, 526–531
using, 519–520
CardDAV, 545
CAs (certification authorities)
derinition of, 108
importing SSL certificates signed by, 130–132
intermediate, 108
introduction to, 65–66
in Profile Manager, 277
signing SSL certificates, 114, 116–121
trust and, 108–109
Case sensitivity
in file sharing services, 330
Finder and, 330
introduction to, 16
CDP (continuous data protection), 159
Certificate Assistant, 121, 127–128
Certificate signing requests (CSRs). see CSR (certificate signing requests)
Certificates. see SSL (Secure Socket Layer) certificates
Certification authorities (CAs). see CAs (certification authorities)
Chain of certificates, 108, 116–121
Chats. see Messages service
ClamAV virus scanning, 492
Classrooms, 385
Client filtering, 404–406
Clients pane, 452–454
Cloud-based storage, 160
Complex permissions, 355–356
Computers
  as administrators. see administrator computers
  labs of, 385
  management of. see NetInstall (Network Install)
  names of, 26–27
  remote, 85
  as servers. see server computers
Configure Network pane, 89
Confirm Settings pane, 236–237
Congratulations pane, 30
Connected Users pane, 328–329
Connecting to Your Server pane, 24–28
Console app
  file sharing services in, 321
  local network accounts in, 256
  local user accounts in, 207
Contacts service
  configuring to OS X to use, 548–551
  configuring with Server app, 546–547
  introduction to, 545
  Knowledge Base documents on, 552
  in mail services, 498–502
  resources on, 552
  review of, 552
  troubleshooting, 546
Continuous data protection (CDP), 159
Corporate workstations, 385
Credentials of accounts, 173
CSRs (certificate signing requests)
  CAs responding to, 130–132
  creating, 128–130
  definition of, 110
D
Data locations, 519
Default image specifications, 403–404
Delegates, 520
Delimited text files, 196–198
Delivery alerts, 147–148
Demilitarized zones (DMZs), 465
Deployment solutions. see NetInstall (Network Install)
Device management. see Profile Manager
Devices pane, 293–294
DHCP (Dynamic Host Configuration Protocol)
  clean up of exercises on, 461–462
  configuration of, 448–454, 456–461
  dynamic assignments in, 447–448
Finder and, 460
introduction to, 445–448
Knowledge Base documents on, 462
leases in, 447
logs in, 455–456
monitoring, 452–454
multiple subnets in, 448
networks in, 446–447
OS X Server and, 8–9
resources on, 462
review of, 463
RFC documents on, 462
server network interfaces in, 449
starting, 452
static address assignments in, 447–448, 453–454
subnet editing in, 449–452
troubleshooting, 454–456
Digital identities, 108
Digital signatures, 108
Directory services. see Open Directory
Directory Utility
    Open Directory and, 232, 234
    in Tools menu, 97
Disabling user accounts, 246
Discover, Offer, Request, Acknowledge (DORA), 456
Disks
    backups of, 160, 162–163
    emergency boot, 385
    encryption of, 18
    external, 162–163
    images in, 391–392
    space in, 14
DMZs (demilitarized zones), 465
DNS (Domain Name System)
    in administrator computers, 61–62
    configuration of, 71–72
    definition of, 69–70
    DHCP services and, 451
domain names, defined, 9
    forwarding servers in, 73–74
    host name configuration in, 28
    hosting requirements of, 70–71
    hosts configuration in, 76–83
    in installation of OS X Server, 20–21
    Kerberos and, 253
    lookup restrictions in, 74–75
    in mail services, 491–492, 493
    network interfaces in, 44–45
    Network Utility in, 71–72, 80–82
    Open Directory and, 234
    primary zones of, 76–78
    providing, generally, 69
    resources on, 83–84
    review of, 84
    troubleshooting, 72
    in VPN service, 434–436
    in Web services, 474–476, 479–480
    zones of, creating additional, 78–80
    zones of, generally, 70
    zones of, primary, 76–78
    zones of, removing redundant, 80–83
Domain Name System (DNS). see DNS (Domain Name System)
DORA (Discover, Offer, Request, Acknowledge), 456
Dovecot, 489
Downloads
Dovecot and, 489
of emails in POP, 491
of Install OS X Mountain Lion, 391, 395
of OS X Server, 21–22, 68
of OS X Server updates, 32, 46–47, 62–64
of profiles, 290, 304, 417
of software updates, 411–415
of SSL certificates, 120, 132, 135
of Student Materials, 7, 46–47, 62–64
of Workgroup Manager, 186
Dynamic assignments, 447–448

E
Edit Access to Services, 187–188, 243
EFI (Extensible Firmware Interface) boot code, 406
E-mails
in Calendar service, 521–524
in Contacts service, 545, 550
delivery alerts for, 148
mail services for. see mail services
Messages service vs., 533
in Profile Manager, 283
quotas of, 492
Emergency boot disks, 385
“Enable screen sharing and remote management,” 86–87, 99–100, 104
Energy Saver
in administrator computers, 59
in installation of OS X Server, 15, 43
in server computers, 43
Enrolling devices, 288, 293–294
Error logs, 467
Ethernet
in administrator computer systems, 56
Airport and, 7
configuring ports for network services, 60
in device account IDs, 282, 306
DHCP services and, 8, 449–451, 457–462
introduction to, 5–9
NetBoot and, 386
for NetInstall, 7, 385–386, 401
for network interfaces, 44
OS X Server and, 7
triggering alerts by unplugging, 156
Existing OS X systems, 34–36, 54–55
Exported formatted files, 199–201
Extensible Firmware Interface (EFI) boot code, 406
Extensible Messaging and Presence Protocol (XMPP), 534
External disks, 162–163
Externally provided DNS, 71

F
Federation of messages, 535, 541
File access. see also file sharing services
ACEs for complex permissions in, 355–356
ACEs for read-only, 366, 376–378
ACL updates in, 373–374, 376
ACLs for, generally, 351–360
ACLs for groups in, 361
ACLs sorted canonically in, 359
adding users to groups in, 365
clean up of exercises on, 378–379
configuring control of, generally, 364–365, 372
confirmation of, 366
deleting items in, 372
File Sharing pane for, 346–348, 353
file system ACLs for, 352
folders in, 371
GIDs for, 360–361
group membership in, 361
group read-only, 373–378
GUIDs for, 360–361
inheritance of ACLs in, 357–358
introduction to, 345–346
by local user accounts, 180
multiple groups in, 361–362
nested groups in, 362
permissions sheets in, 349–350, 375–378
portability of ACLs in, 359
POSIX for, generally, 350–351
POSIX vs. ACLS for, 360–363
propagating permissions in, 359–360
resources on, 379
review of, 379–380
rules of precedence in, 362–363
Server app for, 345–350
share points in, 366–368, 374–375
shared folders in, 365–366
Storage pane for, 348–350, 354–355
text files in, creating, 368–369
text tiles in, viewing, 370–371
UIDs for, 360–361
viewing items in, 372

File sharing services. see also file access
ACLs in, 353
case sensitivity and, 330
clean up of exercises on, 340–341
configuring, 319–320
Connected Users pane and, 328–329
default share points in, 322–323
exploring, 322, 334–335
for file access, generally, 346–348
file-server requirements in, 318–319
FTP service, 315, 331–333
groups in, 319, 338–340
introduction to, 313–315
in local network accounts, 258–260
in local user accounts, 209–214
logs in, 321, 341
maintenance of, 320
monitoring servers for, 320–321
planning, 318–321
protocols in, 315–318
resources on, 341–343
review of, 343–344
Server app for, 319–320
share points in, 321–330
shared folders in, 336–340
starting, 319, 335–336
stopping, 335–336
Time Machine and, 423, 425
troubleshooting, 330–331, 341
users configuration in, 319–320
Index

File system ACLs (access control lists), 352
File Transfer Protocol (FTP), 315, 331–333
File-server requirements, 318–319
FileVault 2, 18
Finder
   AFP services and, 258–260
   browsing for services with, 335
   browsing networks with, 249
   case sensitivity in, 330
   copying files/folders in, 86
   DHCP and, 460
   file access and, 367–372, 374
   in File Sharing, 210–212, 258–263, 335–340
   FTP and, 333
   group access in, 328, 351
   guest users in, 327, 348
   Kerberos and, 254
   NetInstall and, 390, 398, 401
   Time Machine and, 163, 167, 429–430
   VPN service and, 443
   in websites, 463, 471, 480–481
Firewalls, 434
Folders
   badges in, 314
   creating, 336–337, 365–366, 371
   group, 327–328
   in NetInstall, 388
   share points and, 327–328
   shared, 338–340, 365–366
   in Software Updates, 62–63
   in Web services, 477
Formatting drives, 15–18
Forwarding servers, 70, 73–74
FQDNs (fully qualified domain names), 28, 466–471
FTP (File Transfer Protocol), 315, 331–333
Full disk encryption, 18
Full file level copies, 159
Full image backups, 159
Fully qualified domain names (FQDNs), 28, 466–471

G
GIDs (group IDs), 360–361
Gigabit Ethernet
   on Mac Pro computers, 15
   OS X Server and, 7
   support for, 14
Global password policies, 247–248, 260–264
Google Talk, 535
Group IDs (GIDs), 360–361
Group user IDs (GUIDs), 360–361
Groups of devices, 307–309
Groups of users. see also local group accounts
   adding users to, 365
   in file sharing services, 319
   folders for, 327–328
   in local network accounts, 257–258
   manageable preferences payloads for, 284–287
   membership in, 361
Index

multiple, 361–362
nested, 362
in Profile Manager, 282
read only access in, 373–378
share points and, 327–328
in shared director nodes, 257–258
Users & Groups for. see Users & Groups
workgroup. see Workgroup Manager

Guests
access to services by, 327
in Finder, 338
ownership and, 348

GUIDs (group user IDs), 360–361

Hardware
for installation of OS X Server, 12, 14–15
for NetInstall, 385–386
in Server app, 90–91
in Storage pane, 152
Help resources, 97–98
Home folders, 388
Host name configuration, 28
Hosted DNS (Domain Name System), 70–71, 76–83. see also DNS (Domain Name System)
Hosting mail services, 489–493
Hosting websites. see Web services
Hosts in DHCP. see DHCP (Dynamic Host Configuration Protocol)
iCal, 526–531. see also Calendar service
iChat. see Messages service
Identities, 108
Images
backups of, 159
boot, 389–390
default specifications for, 403–404
disk, 391–392
installing, 390
in NetBoot, 397–400
in NetInstall, 388–393, 395–397, 401–404
in NetRestore, 400
restoring, 390
serving, 401–402
in System Image Utility, 97, 383, 388–393
IMAP (Internet Message Access Protocol), 491
Incoming mail blacklists, 493, 497–498
Incoming mail virus scanning, 492, 497
Incremental backups, 159
Independent readers, 46–47, 63–64
Individual software updates, 415–416
Inheritance, 355–356, 357–358
Install OS X Mountain Lion app, 388, 391, 395–397
Installation
of networks. see NetInstall (Network Install)
of OS X Mountain Lion, 388, 391, 395–397
of OS X Server. *see* installation of
OS X Server
of profiles, 288
of Server app, 64–65
of VPN service, 439–441
Installation of OS X Server
Accessing Your Server pane in, 23–24
on administrator computers. *see *
administrator computers
AirPort Management pane in, 29
Apple Push Notifications pane in,
29–30
availability in, 15
computer names in, 26–27
Congratulations pane in, 30
Connecting to Your Server pane in,
24–28
disk space in, 14
DNS records in, 20–21
downloading OS X Server for, 21–22
Energy Saver in, 15
FileVault 2 in, 18
formatting drives in, 15–18
full disk encryption in, 18
hardware requirements for, 12, 14–15
host name configuration in, 28
introduction to, 11, 15
License pane in, 23
logs inspection in, 33
for migrating to OS X Server, 31
Multiple Networks Detected
pane in, 23
network addresses in, 25–26
network configuration in, 18–19
network interfaces in, 14
partitioning drives in, 15–18
preparation for, 15–22
RAID in, 18
RAM in, 14
requirements for, 11–15
resources on, 66–67
review of, 67–68
on server computers. *see* server
computers
starting, 22
system requirements for, 12–14
troubleshooting, 33
updates in, 32–33
upgrades in, 31
Xsan pane in, 29
Instant messaging. *see* Messages service
Instructor-led environments, 44–46
Intermediate CAs (certification
authorities), 108
Internal volumes, 163–164
Internet Message Access Protocol
(IMAP), 491
Internet service providers (ISPs), 492
iOS
access to OS X Server and, 269
in file sharing services, generally,
303–306
FTP and, 331–333
Profile Manager and, 269, 281–288,
302, 309
VPN service in, 437
IP addresses, 466, 471. see also IPv4 addresses
iPads, 525–531
iPhones
    Calendar service on, 520, 531
    WebDAV on, 316
iPod touch, 520, 531
IPv4 addresses
    in DHCP services, 446–448, 450–452, 456–461
    in DNS. see DNS (Domain Name System)
    dynamically assigned, 447–448
    leasing, 447
    in OS X Server, generally, 8
    statically assigned, 447–448, 453
    in VPN service, 435
    in Web services, 472
ISPs (Internet service providers), 492

J
Jabber, 538–541, 550
Journaled formats, 16
Junk filtering, 493, 497–498

K
KDC (Kerberos Key Distribution Center), 221, 247–251
Kerberized services, 249–250
Kerberos
    basics of, 249–251
    Finder and, 254
    global password policies in, 247–248
    local network accounts and, 249–254
    Open Directory and, 234
    tickets in, 251–253
    troubleshooting, 253–254
Kerberos Key Distribution Center (KDC), 221, 247–251
Keychain Access
    archiving certificates in, 133–136
    default certificates in, 110–111
    details of certificates in, 112
    exporting certificates in, 115
    trusted root CAs in, 109
Keynote, 316
Kiosks, 385
Knowledge Base documents
    on Calendar service, 532
    on Contacts service, 552
    on DHCP, 462
    on DNS, 84
    documents in, 67
    on local user accounts, 215
    on mail services, 505
    on Messages service, 543
    on NetInstall, 409–410
    on Open Directory, 239–240
    on Profile Manager, 277
    on Software Update service, 412, 420
    on SSL certificates, 144–145
    on Time Machine, 169, 431
    on VPN service, 434, 443–444
    on Web services, 486
    on Wiki services, 517
L

L2TP (Layer 2 Tunneling Protocol), 433–434
LDAP (Lightweight Directory Access Protocol)
  binding computers to, 389
  in Calendar service, 520
  in Contacts service, 545
database in, 233
directories in, 221
Directory Utility and, 232, 234
hosting copies of, 221
Kerberos and, 249
logs in, 233, 239
manageable preferences payloads for, 284
Open Directory and, 219–221, 231, 234–237
passwords in, 246
populating directories in, 241
Server app configuring, 220
SSL and, 231
Leases, 447
Libraries, 385
License pane, 23
Local group accounts. see also groups of users
  adding groups to, 205–207
  adding local users to, 182–183, 203–205
assigning to local groups, 184
assigning to local users, 183–184
creating, 181–182, 201–202
importing, 202–203
managing access to services with, 189
of networks, 245, 257–258
Users & Groups for. see Users & Groups
Local network accounts. see also networks
  access to services in, 244
  AFP services and, 258–260
  authentication methods for, 249–253
  creating, 254–260
  disabling user accounts in, 246
  global password policies in, 247–248, 260–264
groups of, 245, 257–258
importing, 244–245, 254–260
introduction to, 241
Kerberos and, 249–254
managing with Server app, 241–245
Open Directory masters for, 234–238
password policies for, 247–248, 260–264
resources on, 264–265
review of, 265–266
shared directory nodes in, 254–258
single sign-ons in, 249
troubleshooting, 253–254
Local network groups, 245, 257–258
Local user accounts
  access to files/services by, 180
  access to services by, 187–189, 190, 208–212
administration rights for, 180–181
administrator server accounts and.
   see administrator server accounts
authentication of, 173–175
authorization of, 173–175, 210–212
in Calendar service, 526–531
clean up of exercises on, 213–215
configuration of, 179–184
creating, 175–176, 190–193
credentials of, 173
ing local user accounts
editing users in, 192–193
in file sharing services, 319–320
groups of. see local group accounts
importing, generally, 196
importing, troubleshooting of,
   207–208
importing from delimited text files,
   196–198
importing from exported formatted
   files, 199–201
importing lists of users in, 184–186
importing users to, 190
introduction to, 173
local. see local user accounts
for mail services, 496
manageable preferences payloads for,
   284–287
manually managing access of,
   187–189
in Messages service, 538–540
for networks. see local network
   accounts
new, 191–193
resources on, 215
review of, 215–216
Server app as nonadministrator user
   in, 195–196
Server app creating new, 193–194
Server app for configuring, 176–184
troubleshooting, 189–190
UIDs of, 179
Locales, 222–224
Locally managing profiles, 309
Locations, 524–526
Locking devices remotely, 284
Login windows, 174–175
Logs
   in DHCP, 455–456
   in file sharing services, 321, 341
   in installation of OS X Server, 33
   in Messages service, 535
   in Open Directory, 233
   in Profile Manager, 287
   in Status section, 150
   in VPN service, 437, 441–442
   in Web services, 467
Long names, 177
Lookup restrictions configuration, 74–75

M

MAC (Media Access Control) addresses,
   448, 453–454
Mac App store
   Apple Remote Desktop from, 86
Install OS X Mountain Lion from,
   391, 395
OS X Server from, 7, 21–22
Server app from, 48, 64
updates from, 32

Mail app
  email trails in, 491
Mail, Contacts & Calendars in,
    498–502
  replying to mail in, 504–505
  sending mail in, 502–504

Mail eXchange (MX) servers, 490, 492

Mail services
  Calendar in, 498–502
  Contacts in, 498–502
  DNS configuration for, 491–492
  DNS problems in, 493
  enabling, 494–498
  hosting, 489–493
  incoming mail blacklists in, 493,
    497–498
  incoming mail virus scanning in,
    492, 497
  introduction to, 489
  junk filtering in, 493, 497–498
Knowledge Base documents on, 505
Mail, Contacts & Calendars in,
  498–502
Mail app in. see Mail app
mail quotas for users in, 492, 497
preferences in, 498–502
quotas for users in, 497
receiving mail in, 498–505
relaying outgoing mail in, 492,
  495–496
resources on, 505
review of, 506
  sending mail in, 498–505
  troubleshooting, 493–494
  users, enabling mail for, 496

Manage Devices pane, 90
Manage menu, 96
Manageable preferences payloads,
  284–287
Management
  in AirPort, 29
  of computers, 384–388
  of Messages service, 533–535
  of profiles. see Profile Manager
  remote. see Remote Management
  of Software Update service, 411–412
  of Web services, 466–467, 478–479
  of workgroups, 186–188,
    237–238, 243
Mandatory requirements of OS X Server,
  6–7
Master role, 219–221, 225–227
MDM (Mobile Device Management), 270
Media Access Control (MAC) addresses,
  448, 453–454
Memory Usage, 150–151, 155
Messages
  IMAP for, 491
  in Server Message Block. see SMB
    (Server Message Block)
services for. see Messages service
Messages service
  archives in, 537
  chat logs in, 542–543
  federation of messages in, 535, 541
  introduction to, 533
Knowledge Base documents on, 543
logging messages in, 535
management of, 533–535
port usage in, 534
resources on, 543
restricting federation in, 541
restricting users in, 540–541
review of, 543
set up of, 536–543
troubleshooting, 535–536
users configuration in, 538–540
viewing, 542–543
Microsoft Challenge Handshake Authentication Protocol (MS-CHAPv2), 245
Microsoft Knowledge Base, 444
Migrating to OS X Server, 31
Mobile Device Management (MDM), 270
Monitoring
clients, 408–409
OS X Server, 147–148, 152–156
servers for file sharing, 320–321
Web services, 467, 483–485
Mountain Lion. see OS X Mountain Lion
Mountain Lion 201: OS X Server Essentials 10.8
certification and, 10
defined, 6
introduction to, 3–6
Mounted volumes, 391
MS-CHAPv2 (Microsoft Challenge Handshake Authentication Protocol), 245
Multiple groups, 361–362
Multiple Networks Detected pane, 23
Multiple subnets, 448
MX (Mail eXchange) servers, 490, 492

N

Names
of administrator computers, 58–59
of computers, 26–27
of domains. see DNS (Domain Name System)
fully qualified domain, 28, 466–471
of hosts, 28
of server computers, 41–43
startup volume, 41
of user accounts, 176–179
NAT (Network Address Translation), 29
Nested groups, 362
Nested replicas, 221
NetBoot
Automator workflow items in, 389
boot images in, 389–390
clients in, 406–407
home folders and, 388
images in, 397–400
startup type, 386
NetInstall (Network Install)
Automator workflow items in, 389
boot images in, 389–390
clients in, 404–407
creating images in, 388–393, 395–397
default image specifications in,
403–404
DHCP services and, 445
disk images in, 391–392
hardware requirements for, 385–386
home folders in, 388
install images in, 390
Install OS X Mountain Lion app for,
  388, 391, 395–397
introduction to, 383
managing computers with, 384–388
monitoring clients in, 408–409
mounted volumes in, 391
NetBoot in, 388, 397–400, 406–407
NetRestore images in, 400
resources on, 409–410
restore images in, 390
review of, 410
server configuration for, 400–404
serving images in, 401–402
shadow files in, 393–394
share points in, 402–403
startup types in, 386–388
System Image Utility for, 388–393
troubleshooting, 394–395
using, generally, 390–393
NetRestore
  Automator workflow items in, 389
  images in, 400
  startup type, 386
Network Address Translation (NAT), 29
Network File System (NFS), 317
Network Information Service (NIS), 217
Network Install (NetInstall). see NetInstall
  (Network Install)
Network interfaces. see also networks
  in administrator computers, 60–61
  in installation of OS X Server, 14
  in Server app, 89
  in server computers, 44–47
Network pane
  DHCP in, 461
  DNS Server field in, 33
  overview of, 94
  Server link to, 101
  shortcut to, 89
  SSL certificate use in, 139
Network system preferences, 18–19, 25–26
Network Traffic, 150–151, 155
Network Utility
  checking DNS resolution in,
    80–83, 467
  confirming DNS records with, 20,
    61–62, 71–72
  FQDNs and, 467
  introduction to, 20–21
  MX servers in, 490
  Open Directory and, 225, 234–235
Networks
  accounts for. see local network
    accounts
  addresses of, 25–26, 29
  backing up. see Time Machine
    backups
  in DHCP, 446–447
  File System for, 317
  Information Service for, 217
  infrastructure of, 8–9
  installation of. see NetInstall
    (Network Install)
in installation of OS X Server, 18–19
interfaces for. see network interfaces locations of, 460–461
multiple, 23
perimeter, 465
Software Update in, 412
system preferences for, 18–19
traffic in, 150–151, 155
utility for. see Network Utility
virtual local area, 448
virtual private, 24
Next Steps drawer, 88–90, 101–102
NFS (Network File System), 317
NIS (Network Information Service), 217
Notifications, 149

Open Directory
access to services in, 225
authentication methods in, 245–246
automatic access control in, 187
binding OS X to, 232
binding to other directory services and, 244
buddies in, 539
Calendar service and, 520
certificates in, 121
components of, 220–227
concepts in, 217–225
configuration of, 227–232
Contacts service in, 546–547
definition of, 218
directory services in, 234
Directory Utility and, 232
global password policies in, 246–248
instant messaging and, 535
introduction to, 217
Kerberos and, 249–253
local network accounts in, 245–249
locales in, 222–224
logs in, 233
master role in, 219–221, 225–227
network accounts in, 234–238
in Profile Manager, 270–271, 275
remote use of Directory Utility and, 232
replica role in, 221–222, 227–230
resources on, 239–240
review of, 240
role of using other servers in,
224–225
single sign-ons in, 249–253
SSL certificates and, 109, 116, 121
standalone server role in, 219
Time Machine backups for, 161
troubleshooting, 232–234
Users & Groups in, 230
using other servers role in, 230–232
VPN service and, 439
Workgroup groups in, 237–238
OpenLDAP, 218–220. see also LDAP
(Lightweight Directory Access Protocol)
OS X Mountain Lion
account management in, 281
on administrator computers, 6, 53, 55
app for installing, 388, 391, 395–397
CAs in, 109
Index

OS X Server, overview. *see also specific services*

advanced administrators in, 9
Apple certification in, 10
case sensitive, 10
case insensitive, 10
case sensitive mapping, 11
configuration of, 6–9
devices on, 6–9
device management with. *see Profile Manager*

DHCP in, 8–9
domain names in, 9
drives, 12, 15
full deployment, 12
full deployment of, 12
installing on drives/disks, 15, 36
installing OS X Server and, 11, 15, 39
log files on, 33
mandatory requirement of, 6
migrating OS X Server on, 31
push notifications in, 148
Recovery for, 384
remote management of OS X Server and, 152
remotely locking/wiping devices running, 184
Server app on, 85, 88
on server computers, 6, 34
Sharing settings on, 88
system requirements for, 12–13
Time Machine and, 162, 423
tools in, 97
VPN service in, 437

Over the air (OTA) management, 270
Overview pane, 91
Ownership. *see also POSIX*
defined, 345, 350–351
in File Sharing pane, 346–348
guests and, 348

Order of exercises on, 9
Server app for. *see Server app*
SSL certificates in, 115–116
structure of lessons on, 5–6

Parameter random-access memory (PRAM), 407
Parameters of websites, 470–471
Partition Layout, 17
Partitioning drives, 15–18
Passphrases, 435
Password policies, 247–248, 260–264
Password Server, 234, 237, 247–248
Password Service Error logs, 233
Password Service Server logs, 233
Payloads, 284–287
Peachpit Press, 63–64
Perimeter networking, 465
Permissions. *see also POSIX*

ACEs and, 355–359
ACLs and, 352–355
administrator, 175, 180–181, 355–356
case sensitive, 355–356
defined, 350
debug, 350
for file access, 347–350, 375–378
in File Sharing pane, 347–348
propagating, 359–360

P
Read, 355–356
sheets, 349–350, 375–378
in Storage pane, 348–350
Write, 355–356
PKI (public key infrastructure), 107
Placeholders, 306–307
Point to Point Tunneling Protocol (PPTP), 433–434
POP (Post Office Protocol), 491
Port forwarding, 465
Portability of ACLs, 359
Ports
80, 467
443, 467, 471
8080, 474
8088, 412
AirPort. see AirPort
Ethernet, 7
numbers of, 466–471
usage of, 534
POSIX
ACLs vs., 350–351, 360–363
deny access in, 356
in File Sharing pane, 346–347
in file sharing services, generally, 313
GIDs in, 360–361
GUIDs in, 360–361
multiple groups in, 361–362
overriding, 353
propagating permissions in, 359
rules of precedence in, 362–363
share points and, 345
in Storage pane, 354
UIDs in, 360–361
Post Office Protocol (POP), 491
Postfix, 489
Power failures, 15
PPTP (Point to Point Tunneling Protocol), 433–434
Preferences payloads, 284–287
Primary zones
creating additional, 78–80
definition of, 70
in DNS, generally, 76–78
Private keys, 107, 113–114
Private subnets, 436
Processor Usage, 150–151, 155
Profile Manager
account management with, generally, 281–287
configuration of, 270–271
device account placeholders in, 306–307
device groups, creating and populating, 307–309
Devices pane in, 293–294
enabling, 272–277
enrolling devices in, 288, 293–294
installing profiles in, 288
introduction to, 269–270
locally managing profiles in, 309
logs in, 287
Mobile Device Management in, 270
preference management in, 284–287
preparations for, 270–271
Profiles pane in, 289–294
pushing profiles in, 288
Remote Management in, 295–300
remotely locking/wiping devices in, 284
resources on, 278, 310
review of, 278–279, 310
Software Update service in, 416–419
terminology in, 270
troubleshooting, 287–288
User Portal in, 270
User Profile Portal, Devices pane in, 293–294
User Profile Portal in, generally, 288
User Profile Portal, Profiles pane in, 289–294
User Profile Portal, Remote Management in, 295–300
using, generally, 288, 300–305
viewing logs/profiles in, 287
VPN service in, 435, 437
Web app of, 269
Profiles pane, 289–294
Propagating permissions, 359–360
PTR records, 71
Public key infrastructure (PKI), 107
Push notifications. see Apple Push Notifications (APNs)
Pushing profiles, 288

R
RAID (Redundant Array of Independent Disks), 18
RAM, 14
Read permissions, 355–356
Read-only access
ACEs for, 376–378
to items, 372
in Read permissions, 355–356
Receiving mail, 498–505
Redundant Array of Independent Disks (RAID), 18
Relaying outgoing mail, 492, 495–496
Remote computers, 85
Remote Management
in administrator computers, 58–59
in Profile Manager, 295–300
in Server app, 86–87, 99–100
in server computers, 41–43
Remote use of Directory Utility, 232
Remotely locking/wiping devices, 284
Replica role, 221–222, 227–230
Requestors, 70
Restoring images, 390
Restoring OS X Server, 167–168
Restricting federation, 541
Restricting users, 540–541
Review Certificates pane, 89
RFC documents, 462
Root CAs (certification authorities), 108–109

Q
Qualification of computers, 39–41
Safari
SSL certificates in, 117–118, 139–143
Web services in, 468–476, 479, 481–483
Wiki services in, 509–511
Scheduling. see Calendar service
Scope, defined, 447
Screen Sharing
in Server app, 86–88, 99–100
in Tools menu, 97
Secondary zones, 70
Secure Socket Layer (SSL) certificates. see SSL (Secure Socket Layer) certificates
Security in OS X Server. see VPN service
Security of Web services, 479–483
Self-Monitoring, Analysis and Reporting Technology (S.M.A.R.T), 152
Self-signed SSL certificates. see also SSL (Secure Socket Layer) certificates
creating, 112–113, 121–128
CSRs for, 128–130
inspecting, 113–114
replacing with CA-signed, 114
in Web services, 481–483
Sending mail, 498–505
Server app. see also OS X Server, overview
access to services in, 209–212
Accounts section in, 95
Add Users pane in, 89
on administrator computers, 64–68
Alerts pane in, 154–155
Calendar service in, 521–526
Configure Network pane in, 89
Contacts service in, 546–547
DHCP services in, 448–454
for file access. see file access
file sharing services in. see file sharing services
Hardware section in, 90–91
Help resources in, 97–98
introduction to, 85
local groups in, 181–184, 201–208
local network accounts in. see local network accounts
Manage Devices pane in, 90
Manage menu in, 96
Messages service on, 536
monitoring OS X Server with,
147–148, 152–156
network interfaces in, 89
Network pane in, 94
Next Steps drawer in, 88–90, 101–102
for nonadministrator users, 195–196
Notifications in, 149
Open Directory in. see Open Directory
Overview pane in, 91
remote management in, 85–88, 99–100
resources on, 103
Review Certificates pane in, 89
review of, 104–105
Screen Sharing in, 86–88, 99–100
self-signed certificates in, 128–130, 137–138
Service Data in, 92–93, 102–103
Services in, 95–96
Settings pane in, 92–93
sidebar elements in, 90–96
signed certificates in, 131–132
Software Update in, 413, 415–416
SSL certificates in, 89
Start Services pane in, 90
Status section in, 95, 148–151
Storage pane in, 94–95, 152
Time Machine in, 423–425, 431
Tools menu in, 97
troubleshooting, 98
user accounts in. see local user
accounts
Users pane in, 89
VPN service in, 434–437
Web services in. see Web services
Wiki services in, 508–513
Server computers
Energy Saver preferences in, 43
existing OS X systems on, 34–36
independent readers and, 46–47
installation of OS X Server on, 34,
39–41, 48–52
instructor-led environment and,
44–46
names in, 41–43
NetInstall on, 400–404
network interfaces in, 44–47, 449
Remote Management in, 41–43
Setup Assistant for, 36–39
Software Updates in, 44
SSL certificates in, 136–138
startup volume names in, 41
student numbers in, 34
Server Fallback SSL Certificate, 124
Server Message Block (SMB). see SMB
(Server Message Block)
Service Data field, 92–93
Service data volume, 102–103
Services, 95–96
Serving images, 401–402
Settings pane, 92–93
Setup Assistant, 36–39, 55–58
Shadow files, 393–394
Share points
ACEs and, 323
adding, 323–325
in AFP services, 322
case sensitivity and, 330
configuring access to, 366–368
configuring individual, 326–327
Connected Users pane and, 328–329
default, 322–323
in file access, 374–375
in file sharing, generally, 321–330
in File Sharing pane, 346–348
folders and, 327–328
groups and, 327–328
introduction to, 313–314, 321–322
in NetInstall, 402–403
as network volumes, 314
removing, 323–325
Shared secrets, 435
Sharing preferences, 86–88
Short names, 177
Sidebar elements in Server app, 90–96
Signatures
   by CAs, 114, 116–121, 130–132
   requests for, 128–132
   by self, 113–114, 121–128, 137–138
   by Verisign, 117–119
Simple Mail Transfer Protocol (SMTP), 490, 492, 495–496
Single sign-ons, 249
S.M.A.R.T (Self-Monitoring, Analysis and Reporting Technology), 152
SMB (Server Message Block)
   authentication and, 174
   case sensitivity in, 330
   Connected Users pane and, 328
   File Sharing and, 189, 209
   guest access in, 327
   home directories over, 327
   introduction to, 209, 315–318
   Kerberos and, 250–252
   monitoring servers via, 320
   ownership and, 351, 366
   permissions and, 351, 366
   share points and, 319, 322
   shared folders in, 323
   on Snow Leopard, 315
   ticket-granting tickets and, 250–252
   on Windows, 189, 209
SMTP (Simple Mail Transfer Protocol), 490, 492, 495–496
Snow Leopard
   installing OS X Server and, 15
   migrating OS X Server on, 31
   SMB on, 315
Time Machine on, 423
   upgrading OS X Server on, 31
SoA (Start of Authority), 72
Software Update service
   in administrator computers, 59–60, 62–63
   configuration of, 44, 413–416
   configuring computers for, 416–419
   individual updates in, 415–416
   introduction to, 411
   Knowledge Base documents on, 412, 420
   manageable preferences payloads for, 287
   management of, 411–412
   resources on, 419–420
   review of, 420
   Server app and, 93
   on server computers, 44
   Snow Leopard Server versions in, 31
   in Student Materials, 46–47
   System Preferences configuring, 34
   troubleshooting, 412–413
SpamAssassin, 493
Spotlight ACEs, 350
SSH connections, 87–88
SSL (Secure Socket Layer) certificates
   for administrator computers, 65–66, 138
   archiving, 114–115, 133–136
   binding servers to other servers and, 230–232
   in Calendar service, 524
CAs for, selecting, 116–119
CAs for, trusting, 119–121
CAs signing, 114, 130–132
certificate chain and, 116–119
clean up of exercises on, 144
configuration of, generally, 107, 110
configuring OS X Server for, 115–116
in Contacts service, 546–547
CSRs for, 128–130
importing CA signatures for, 114
in Messages service, 536–547
overview of, 107–110
private keys in, 113–114
in Profile Manager, 271, 275
reimporting exported, 134–136
resources on, 144–145
review of, 145
self-signed, creating, 112–113, 121–128
self-signed, inspecting, 113–114
self-signed, replacing with
CA-signed, 114
in Server app, 89
servers using new, 136–138
in System keychain, 113–114
troubleshooting, 121
trust in, 119–121, 142–143
viewing default, 110–112
in Web services, 139–142, 479–483
in Wiki services, 508–511
Standalone server role, 219
Start of Authority (SoA), 72
Start Services pane, 90
Startup types, 386–388
Startup volume names, 41
Static address assignments, 447–448, 453–454
Stats pane, 150–151
Status section
Alerts pane in, 148–149
Logs pane in, 150
in Server app, 95
Stats pane in, 150–151
Storage pane
ACLs in, 354–355
for file access, generally, 348–350
in Hardware section, 152
in Server app, 94–95
system requirements in, 13
Student numbers, 34
Subnet editing, 449–452
System files, 428
System Image Utility
for NetInstall, 383, 388–393
in Tools menu, 97
System keychain, 113–114
System Preferences
administrator accounts in, 35–36, 180–181
on administrator computers, 53–55, 59–61
computer names in, 58–59
DHCP services in, 458–461
Energy Saver in, 43, 59
local administrator accounts in, 53–55
Mail app in, 498
NetInstall in, 406–407
Network pane in, 33, 44–45, 60–61
Open Directory in, 230
remote administration of, 175
Remote Management in, 42–43, 58–59
on server computers, 34–36, 42–44
services configured with, 34
Software Update in, 44, 59–60, 418
SSL certificate verification in, 139
Startup Disk in, 388, 390, 406–407
Time Machine in, 164–166, 426–427
VPN service in, 439–440
website configuration in, 472–476
System requirements, 12–14

T
Tape backups, 160
TCP (Transfer Control Protocol), 315
Text files
creating, 368–369
editing, 369–370
viewing, 370–371
Text messages. see Messages service
TextEdit
creating text files in, 368–369, 429
creating websites in, 472
editing text files in, 369–370
Profile Manager and, 304
restoring files in, 429–430
Time Machine and, 429
viewing text files in, 370–371
Web services in, 472–473, 480
TGTs (ticket-granting tickets), 250–252
Theater, 533
Thunderbolt ports, 7, 14
Ticket Viewer, 251–254
Ticket-granting tickets (TGTs), 250–253
Tilde character (~), 207
Time Machine backups
clean up of exercises on, 430–431
configuration of, 164–166
configuring OS X computers for,
426–427
excluding system files from, 428
external disks as destinations for,
162–163
internal volumes as destinations for,
163–164
introduction to, 160–162
Knowledge Base documents on, 431
for network backups, 423–430
of OS X Server, 162–166
resources on, 430–431
restoring files in, 429–430
restoring OS X Server from, 167–168
review of, 432
Timestamps, 253
Tools menu, 97
Transfer Control Protocol (TCP), 315
Troubleshooting
access to services, 190
Calendar service, 520–521
Contacts service, 546
DHCP services, 454–456
DNS services, 72
file sharing services, 330–331, 341
installation of OS X Server, 33
Kerberos, 253–254
local network accounts, 253–254
local user accounts, 189–190, 207–208
mail services, 493–494
Messages service, 535–536
NetInstall, 394–395
Open Directory, 232–234
Profile Manager, 287–288
Server app, 98
Software Update service, 412–413
SSL certificates, 121
VPN service, 437
Web services, 467
Wiki services, 508
Trust
  in CAs, 108–109
  in Keychain Access, 109
  in SSL certificates, 119–121, 142–143

U
UIDs (user IDs), 179, 360–361
Unverified SSL certificates, 112
Updates pane, 414–415. see also Software Update service
Upgrading to OS X Server, 31
URLs
  on access to files, 379
  on file sharing services, 343
  in NetInstall, 410
  on Open Directory, 240
  in Web services, 466, 486
User accounts. see local user accounts
User IDs (UIDs), 179, 360–361
User Portal, 270, 283, 284
User Profile Portal
  Devices pane in, 293–294
  introduction to, 288
  Profiles pane in, 289–294
  Remote Management in, 295–300
Users. see user accounts
Users & Groups
  adding groups in, 206
  administrator servers and, 175
  binding servers to other servers and, 230–232
  Directory Utility and, 232
Users pane, 89, 424

V
Verisign, 117–119
Viewing logs, 287
Viewing profiles, 287
Virtual local area networks (VLANs), 448
Virtual Private Networks (VPNs), 24
Virus scanning, 492, 497
VLANs (virtual local area networks), 448
VPN service
  advanced configuration options for, 435–436
  clean up of exercises on, 442–443
configuring, generally, 438–541
configuring with Server app, 434–437
Finder and, 443
installing on administrator computers, 439–441
Knowledge Base documents on, 434–444
logs in, 437, 441–442
resources on, 443
review of, 444
saving configuration profiles for, 436–437
for security, generally, 433–434
troubleshooting, 437

W

Web app, in Profile Manager, 269
Web links, 283
Web services
  access management in, 478–479
  creating new websites in, 471–476
disabling, 466
disabling websites in, 485
enabling, 468
enabling websites in, 466
folder access verification in, 477
introduction to, 465
Knowledge Base documents on, 486
managing websites in, 466–467
monitoring, 467, 483–485
parameters of websites in, 470–471
resources on, 485–486
review of, 486
security in, 479–483
software for, 465
SSL in, 139–142, 479–483
starting, 468–470
structure of websites and, 465–467
troubleshooting, 467
URLs on, 486
verification of, 139–142
WebDAV (Web-based Distributed Authoring and Versioning), 315–318, 519
Websites service, 137–138, 142
Wi Fi
  Ethernet vs., 37
  mandatory requirement of, 7
  multiple interfaces for network access, 25
  NetInstall and, 386
  as primary network connection, 14, 56
  in Profile Manager, 270
  SSL certificates and, 139
Wiki services
  creating wikis in, 513–516
  enabling, 508–513
  introduction to, 507
  Knowledge Base documents on, 517
  resources on, 517
  review of, 517
  troubleshooting, 508
Wikis, 520
Windows file service, 315
Wiping devices remotely, 284
Workgroup Manager
  local network accounts in, 243
  local user accounts in, 186, 188
  Open Directory and, 237–238
Write permissions, 355–356

X

XMPP (Extensible Messaging and Presence Protocol), 534
Xsan, 29, 97

Z

Zones, DNS
  creating additional, 78–80
  in DNS hosts configuration, 76–78
  introduction to, 70
  primary, 76–78
  removing redundant, 80–83